
	User guidance
The standard form following is for the preparation of a tender document for Project Management Services
Part 2: Tender Schedules
Guide notes
This standard form contains guidance in hidden text, ie:
GUIDE NOTES;
Guide Note examples
Viewing guide notes
1. If the guide notes are not visible, click on the Show/Hide button [image: image1.bmp].
2. If still not visible, then:

•  At the Tools menu;

•  Click Options, and click the View tab;
•  Tick the Hidden Text check box and click the OK button.
Insertion points
Each ‘»’ shows where input is required. Click onto each ‘»’ and overtype.
When completed
1. Remove all guide notes manually or by the following steps:
•  On the Edit menu click Replace, then (if required) 
•  Click the More button;
•  Click the Format button, click on Font;
•  Tick the Hidden check box and click the OK button;
•  Click the Special button, click on Any Character; then
•  Click the Replace All button.
2. Delete this User guidance, along with the following Page Break.
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Tender Schedules

Complete the details for each Tender Schedule to be used.  

Delete Schedules not used,

Make sure that each Tender Schedule has the name of the engagement in the Footer.

ADDITIONAL RETURNABLE SCHEDULES MAY BE includED TO SATISFY PARTICULAR NEEDS. 

when the tender document is issued in hard copy Provide one set of schedules loose for submission by Tenderers.

Use option 1 FOR A TENDER NOT USING THE TWO-ENVELOPE SYSTEM

USE option 2 FOR A TENDER USING THE TWO-ENVELOPE SYSTEM

option 1 

The following Tender Schedules must be completed and submitted as part of the tender:

· Tender Form

list each Tender Schedule by heading

· »

end of option 1

option 2

The following Tender Schedules must be completed and submitted as part of the tender:

Envelope 1 (Non-Price Schedules)

list each Non-Price Tender Schedule by heading

· »

Envelope 2 (Price Schedules)

· Tender Form

list each Price Tender Schedule by heading

· »

end of option 2

Tender Form

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 2)

Tenderer’s details

	Name:
(in block letters)
	………………………………………………………….…………

……………………………………………………….……………

ABN ...………………….…………………………….….……….

	
	

	Address:
	……………………………………………………….……………

………………………………………………………….…………

	
	

	Telephone number:
	……………………………………………………………….……

	Facsimile number:
	……………………………………………………….……………

	e-mail address:
	………………………………………………………….…………

	
	

	
	hereby tender(s) to perform the services for


Tender details

Ensure that the details match the agreement name and number used on the title page.

	Agreement name:
	» 

	Contract number:
	»

	
	in accordance with the following documents:


Where applicable, List all Tender Documents by Volume, for Example:

Tender Document Volume 1 – Specification

Tender Document Volume 2 - Drawings

Amend the following list to ensure that the Volume names and numbers correspond with the Table of Contents

	
	Tender Document »

	
	»

	
	and Addenda Numbers: …………………………………….……


Tenderer’s offer

	For the Fee, being the lump sum of:

	…………………………………………………………………………………………….

	…………………………………………………………………………………………….

	($……………………………………………) including GST.


Schedule of Prices

(SUBMIT WITH TENDER FORM)

Include when dissection of the tendered lump sum is required, otherwise delete.

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 2)

Insert the amount allowed for each of the following items.

This Schedule is for information only and does not form part of the Agreement.  Its purpose is to assist in making valuations of services carried out but the Principal is not bound to use it.

All amounts must include an amount for GST.

amend the following content by addition and deletion of deliverables required under the services.

item No A is mandatory.

number items in the pattern shown.

the list of deliverables hereunder must agree with the list of deliverables at the services.

	No.
	Item
	Rate
	Amount $ 

	A
	All activities and obligations under the Agreement not included elsewhere in the Fee.
	Lump Sum
	


Expand the table by inserting rows, as required.

	1
	Service Demand Identification

	1.1
	Service outcomes strategy
	Lump Sum
	

	1.2
	Asset Strategy plan
	Lump Sum
	


Expand the table by inserting rows, as required.

	2
	Service Delivery Options

	2.1
	Service delivery options study
	Lump Sum
	

	2.2
	Feasibility analyses
	Lump Sum
	

	2.3
	Preliminary risk identification and risk management schedule
	Lump Sum
	

	2.4
	Stakeholder identification
	Lump Sum
	

	2.5
	Cross agency impact statement
	Lump Sum
	


Expand the table by inserting rows, as required.

	3
	Justification of Proposed Option

	3.1
	Project Strategy Report
	Lump Sum
	

	3.2
	Preliminary financial and economic appraisal
	Lump Sum
	

	3.3
	Heritage impact study
	Lump Sum
	

	3.4
	Traffic impact study
	Lump Sum
	

	3.5
	Environmental impact study
	Lump Sum
	

	3.6
	Preliminary risk assessment
	Lump Sum
	

	3.7
	Preliminary project budget
	Lump Sum
	

	3.8
	Preliminary project program
	Lump Sum
	


Expand the table by inserting rows, as required.

	4
	Project Definition

	4.1
	Project Appraisal
	Lump sum
	

	4.2
	Feasibility Study Report
	Lump sum
	

	4.3
	Economic Appraisal
	Lump sum
	

	4.4
	Financial Appraisal
	Lump sum
	

	4.5
	Value Management study report
	Lump sum
	

	4.6
	Risk management plan
	Lump sum
	

	4.7
	Project Budget
	Lump sum
	

	4.8
	Project Program
	Lump sum
	

	4.9
	Stakeholder views analysis
	Lump sum
	

	4.10
	Change management assessment
	Lump sum
	

	4.11
	Benefits realisation register
	Lump sum
	

	4.12
	Business Case submission
	Lump sum
	


Expand the table by inserting rows, as required.

	5
	Procurement Strategy 

	5.1
	Project procurement plan
	Lump sum
	

	5.2
	Advice on sourcing tenderers
	Lump sum
	

	5.3
	Updated risk management plan
	Lump sum
	

	5.4
	Change management plan
	Lump sum
	

	5.5
	Communication plan
	Lump sum
	

	5.6
	Project organisation chart & resource schedule
	Lump sum
	

	5.7
	Report on stakeholder support
	Lump sum
	

	5.8
	Procurement Strategy Report
	Lump sum
	

	5.9
	Project Budget & cash flow
	Lump sum
	

	5.10
	Updated Project Program
	Lump sum
	


Expand the table by inserting rows, as required.

	6
	Specification

	6.1
	Geotechnical report
	Lump sum
	

	6.2
	Contamination report
	Lump sum
	

	6.3
	Hazardous materials report
	Lump sum
	

	6.4
	Dilapidation report
	Lump sum
	

	6.5
	Field survey
	Lump sum
	

	6.6
	Approvals from relevant authorities
	Lump sum
	

	6.7
	Tender documents
	Lump sum
	

	6.8
	Tender evaluation plan
	Lump sum
	

	6.9
	Pre-tender estimate
	Lump sum
	


Expand the table by inserting rows, as required.

	7
	Service Provider Selection 

	7.1
	Tender evaluation, recommendation, approval
	Lump sum
	

	7.2
	Contract documents
	Lump sum
	

	7.3
	Completed tender award actions
	Lump sum
	

	7.4
	Post Tender Review Report confirming completion of contract award actions
	Lump sum
	


Expand the table by inserting rows, as required.

	8
	Implementation

	8.1
	Schematic design
	Lump sum
	

	8.2
	Developed design
	Lump sum
	

	8.3
	Design documentation
	Lump sum
	

	8.4
	Acceptance test reports
	Lump sum
	

	8.5
	Completed and verified asset
	Lump sum
	

	8.6
	Contract management records
	Lump sum
	

	8.7
	Finalised Contracts
	Lump sum
	

	8.8
	Commissioning plans
	Lump sum
	

	8.9
	Asset management information
	Lump sum
	

	8.10
	Performance reports on Service Providers
	Lump sum
	


Expand the table by inserting rows, as required.

	9
	Operation

	9.1
	Operation plans
	Lump sum
	

	9.2
	Maintenance plans
	Lump sum
	

	9.3
	Maintenance records
	Lump sum
	


Expand the table by inserting rows, as required.

	10
	Evaluation

	10.1
	Report on benefits and level of service
	Lump sum
	

	10.2
	Report on Project Budget and Project Program
	Lump sum
	

	10.3
	Strategies for renewal or discontinuation of service
	Lump sum
	

	10.4
	Performance reports on Service Providers
	Lump sum
	

	10.5
	Post completion/implementation reports and reviews
	Lump sum
	

	10.6
	Benefits realisation report
	Lump sum
	


	
	
Total of tendered Lump Sums
	
$ ………….….


End of Tender Schedule - Schedule of Prices.

 Hourly Rates for Variations

Include this tender schedule if hourly rates for variations are required, Otherwise delete

Insert the Project roles for which rates are sought.  Add or delete rows as required.

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 2)

Supply a list of proposed personnel and rates for variations to the Services. Include key personnel.

Rates for salaried staff if on a weekly basis must state whether based on a 5 day or 6 day week, and shall be loaded to include all items such as base salary, payroll tax, holidays, long service leave, workers compensation insurance, company benefits and any other allowances and FBT. Weekly rates must allow for 8 hrs and over /day.

Hourly rates must be provided for wages staff and shall be loaded to include all items such as fares, holidays, annual leave loading, sick leave, pay roll tax, workers compensation insurance, common law provisions and allowances.

Rates must cover all costs and allowances such as profit, overhead, and margins and shall be inclusive of GST.

	Name
	Project Role
	Rate
($/5-day week)
	Rate
($/6-day week)
	Rate
($/Hour)

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	


End of Tender Schedule - Schedule of Hourly Rates for Variations

Agreement Information items

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

2
Project Manager

	The Project Manager is:
	……………………………………………...


7
Project Manager’s Representative

	The Project Manager’s Representative is:
	……………………………………………...


17
Notices

Notices to the Project Manager 

For notices to the Project Manager the intended recipient is the Project Manager’s Representative:

	Office address:
(for delivery by hand)
	…………………………………………..

…………………………………………..

…………………………………………..

	
	

	Postal address:
(for delivery by post)
	…………………………………………..

…………………………………………..

…………………………………………..

	
	

	Facsimile number
	…………………………………………...

	E-mail address
	…………………………………………...


Outline Services Delivery Plan

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

Prepare an Outline Services Delivery Plan for the Services.

The Outline Services Delivery Plan must include, as a minimum:

the following list contains examples of what might be expected to show an understanding of the project management role. 

add and delete as required:

· to suit the nature of the services

· according to the tender schedules used (ie do not ask for information here which is covered in a tender schedule)

create tender schedules in lieu when more specific or comparable information is required to compare tenders.

1. An outline program for the Services showing time allowed for key activities, milestones or points at which reviews are planned. 

2. A Project chart showing key players including stakeholders.

3. Proposed organisational structure for each phase of the Services.

4. Procedures and checklists proposed and typically used on projects.

5. Quality management proposed with examples of typical quality management plans for past projects.

6. Environmental management proposed with examples of typical environmental management plans for past projects.

Schedule of Key personnel

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

Provide information on key personnel proposed for the Services. Include separately for subconsultant key personnel.

Use the following table as a guide.

Attach an electronic CV for each key person highlighting relevant experience.

	Name
	Position
	Discipline
	Project Role
	Duration of Role

	
	
	
	Project Manager’s Representative
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	


Schedule of Quality Management System information

Include this Tender Schedule when design or design management is involved in the services.

Otherwise delete

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

Current status of quality management system

	Does the Tenderer have a third party certified quality management system to AS/NZS ISO Standard 9001:2000?
	· Yes, or 
· No


If “Yes”:

	· Name of certifying third party:
	………………………………………………

	· Date of last internal audit:
	………………………………………………

	· Date of last external audit:
	………………………………………………


· Submit an electronic copy of the internal audit log.

End of Tender Schedule - Schedule of Quality Management System information

Industrial relations

Include this schedule when the project manager will be managing major site operations, Otherwise delete

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

Demonstrate an understanding of the industrial issues that may affect the Contracts, and describe the Tenderer’s industrial relations management performance on recent projects with particular reference to such issues.

Demonstrate, in particular, an understanding of the mechanisms proposed for coordinating the overall industrial relations, site security and site/project induction processes involved with the Contracts.

Include: -

· A description of the awards and enterprise, workplace or other enforceable agreements that are expected to apply for the Contractors’ and Project Manager’s personnel.

· A statement explaining how compliance with the NSW Government Code of Practice for Procurement will be achieved and verified.

· A description of the industrial relations expertise to be made available as part of the Services.

· Identification of the industrial relations and security issues expected to be involved with the Contracts and the approach proposed to deal with these issues.

· A description of how compliance with the NSW Government Industrial Relations Management Guidelines will be achieved.

The NSW Government Industrial Relations Management Guidelines are available at:

http://www.nswprocurement.com.au/Procurement-System-for-Construction/Reference-material/Procurement-Guideline-Documents.aspx
end of tender schedule – Industrial relations

OHS management

Include this schedule when the services include management of construction contracts, otherwise delete

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

Provide the following information for the organisation proposed as the Project Manager.  Additional documentation may be attached as required.

OHS Policy

	Does the Tenderer have a formal OHS Policy? 
	· Yes, or 
· No


If “Yes”, submit an electronic copy.

Status of OHS Management System

The Tenderer’s OHS Management System is:

· Under development;

· Covered in another Management System;

· Fully developed but not accredited;

· Fully developed and accredited by a third party or government organisation:


Name of organisation:………………………………………………………..

OHS Management Plan for the Services

Submit an electronic version of the outline OHS Management Plan for the Services.

The outline OHS Management Plan must demonstrate the mechanisms and processes proposed for achieving, including through the Service Providers:

· safety in preparing for and undertaking the Services and the work under the Contracts; integration of this outline Plan into the Tenderer’s overall management system and structure; and

· the overall safety and security of work sites for the Contracts. 

Submit an electronic copy of a OHS Management Plan used on another comparable project (if available).

Describe the Tenderer’s experience in implementing and using the OHS Management System and OHS management plans for other similar and/or relevant projects. Include achievements against key performance indicators.

Judgements under OHS legislation

	Have any judgements made against the Tenderer or any proposed Tenderer’s subcontractors or subconsultants under any OHS legislation? 
	· Yes, or 
· No


If “Yes”, submit an electronic copy and:

· list any judgements made against the Tenderer or any proposed Tenderer’s subcontractors or subconsultants under any OHS legislation;

· describe the issues involved; and

· describe the corrective action taken.

OHS awareness/ qualifications/training and experience

Describe the OHS awareness/ qualifications/training and experience possessed by the Tenderer’s personnel, with particular emphasis on those personnel who will have a designated responsibility for OHS management with the Services.

	

Name
	

Position
	

Project Role
	OHS awareness/ qualifications/training and experience 

	
	
	Project Manager’s Representative
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	

	
	
	
	


Describe how it is proposed to maintain and enhance OHS awareness of the Tenderer’s personnel (including subconsultants) and others involved in the Services.

Experience using contract systems

This schedule is used to help ascertain the Tenderer’s experience in contract management.

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

Provide details of experience with and knowledge of the contract systems listed at the Appendix “Instruments for the Services”.

Tenderers may list experience with other contract systems but these will not be as highly regarded (except for C21 Construction Contracts).

Comparable experience

This schedule is used when the project manager will be managing a major project

delete the following line unless using the two-envelope tendering system.

(SUBMIT IN ENVELOPE 1)

Supply details of services provided for projects of a similar size and/or nature. List the five most comparable/relevant projects completed in the previous five years. Include the following details:

· The name of the Client;

· The Client contact name;

· The Client contacts telephone number;

· A short description of Project and Services;

· The $ value of Project; and

· The Project start date & duration.

Insert the Name of project and/or contract and theContract No.

The details must match those on the title page

	
	

	»

Contract No: »
	Page 1


Consultancy Services: Fee over $30,000

Insert the Name of project and/or contract and theContract No.

The details must match those on the title page

	
	

	»

Contract No: »
	Page i


Project Management Services


